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INTRODUCTION TO C-PEN
Congratulations - you have just bought
yourself a photographic memory! C-Pen is
a Mobile Information Collector that reads,
remembers, processes and transfers printed
text cordlessly to your Windows-equipped
PC. C-Pen is in essence an electronic high-
lighter that remembers the text that you are
marking. Carry it with you wherever you
go!

Your Personal Digital Assistant
Make it a habit to bring your portable text
collector with you, and you are always
ready to read and save text from books,
papers, brochures or business cards. You
can easily record price-lists, timetables,
wine-tips or witty quotes. You don’t have
to tear out pages any more.

Your saved text files can later be transferred to your PC.
It is also possible to use C-Pen to read text directly into a
Windows application in your PC.

Powerful features
C Read is the basic function of C-Pen. Move C-Pen

over the text, and the text will be placed in
C-Pen, where you can save it as a file for
later processing.
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C Direct enables you to transfer the read text directly
from C-Pen into your PC. The text will be
placed at the cursor position in for instance a
Word or Excel document.

C Address is an application in C-Pen for storing and
looking up contact information such as
addresses, phone numbers and e-mail
addresses. C Address can be synchronized
with Microsoft Outlook and supports the
vCard standard.

C Write gives you the possibility to enter characters
by writing with C-Pen as an ordinary pen.
This is useful when editing text, entering file
names or searching for a contact in C Address.

Optimum reading conditions
C-Pen uses Optical Character Recognition (OCR) to read
text. OCR is the process of turning an image of characters
into computer-readable text.

As C-Pen is moved over the text, C-Pen’s internal light
source illuminates the characters and a camera takes
images of the text. During OCR, C-Pen analyzes the
images taken by its camera and translates them into text
characters.

The OCR quality will depend on the reading conditions.
The most common confusions between characters with
OCR are:

e → c l → I t → c

r+n → m i → l c → o
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The following conditions affects the quality of the
character recognition:

• The print quality of the text
High-quality printed text produces, of course, maxi-
mum OCR accuracy. With lower-quality pages, e.g.
fax copies, OCR accuracy may be poorer. You can
calibrate C-Pen to optimize its performance under
difficult conditions; see Calibration,   p. 43.

NOTE: C-Pen only recognizes machine-printed
characters such as laser-printed or typewritten text.
C-Pen does not recognize handwritten text.

• Position and movement of C-Pen
It is important how you hold and move C-Pen over the
printed text. Please read the Quick Start folder to learn
how to use C-Pen correctly. It is crucial that you
follow these instructions in order to get the best results.

• The language of the text
See Text Language, p. 43.

• Deformed characters
Anything that is not a printed character, and any
character distorted by a mark or smudge on the paper
could be unrecognizable.

• Overlapped characters
Characters in the text should not overlap.

• Italics and underlined text
Italics are, for some fonts, difficult for C-pen to read.

Underlined text is difficult for C-Pen to read because
the underline changes the shape of descenders of the
letters q, g, y, p, and j.

!
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• Certain colors
C-Pen cannot read red or yellow text on a white or red
background, or white text on a red background.

• Small or large character sizes
The size of the characters should be 7–20 points.

User documentation and support
There are different sources to support your use of C-Pen:

• This User Manual contains a description of C-Pen and
instructions for reading, editing and saving files. The
applications Notes, C Address, C Direct, C Write and
Settings are explained. You will also learn how to
connect C-Pen to a PC.

• The attached CD contains the C-Pen Windows Software
for communication between C-Pen and your PC, as
well as a Readme file on how to install and configure
your computer for infrared communication. The User
Manual is available in several languages on the CD.

• When using C-Pen together with your PC, you have
access to online help, which is automatically installed
on your PC, when you install the C-Pen Windows
Software. The help topics are mostly related to the
C-Pen Windows Software. Instructions for using
C Direct is more thorough in the online help than in
this manual.

• Visit our website to get the latest C-Pen news and free
software upgrades. On our website you will also find
several language versions of User Manual, trouble-
shooting and FAQ (Frequently Asked Questions).
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Care & Safety
• Keep C-Pen away from direct sunlight, heat, moisture

and dust.

• Do not expose C-Pen to extreme variations in tempera-
ture.

• Make sure that the camera opening is free from dust or
any other objects.

• Clean C-Pen with a dry cloth. Do not use detergents or
other chemicals when cleaning C-Pen.

• Use only 1.5 V AAA batteries of type LR03 (alkaline)

• Make backup copies of your C-Pen files regularly and
keep the copies in a safe place.
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PRESENTATION OF THE PEN

Parts of the pen

On/Off Turns C-Pen on or off, when pressed for one
Nav second.

This button is also used as a control for
moving around in menus and texts (turn
control left or right) and to select an item or
an option (press briefly).

Display Used to display read text and for communi-
cation between C-Pen and the user.

Escape button (ESC)

Trigger button
(Trigg)

Navigation control (Nav)
and On/Off button

IR port

Display

Trigger button
(Trigg)

Camera opening

 Battery compartment
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The orientation of the text on the display can
be changed to suit left-handed users. See
System Settings, p. 45.

IR port The infrared (IR) port is used for wireless
data transfer between C-Pen and a PC that
also is equipped with an IR port.

Trigg To be pressed and held down while reading
text.

ESC Closes menus.

The function of Trigg and ESC can be
exchanged to suit your own preference. See
System Settings, p. 45.

Display objects
C-Pen uses the following display objects to communicate
with you:

• status field

• application icon

• menu

• check box

• dialog box

• edit field

• dialog button
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Status field
The area on the left side of the display is called the status
field. This field displays the text settings (Text Quality
and Text Language). See Settings, p. 42.

Application icon
The applications are represented by application icons in
the Main screen. The applications will all be described in
the chapter Applications, p. 32.

Menu
Menus provide different options. A scroll bar indicates if
there are more menu items available above or below.

Check box
Check boxes also provide different options. A check box
remains checked until you uncheck it.

Text Language (see Settings)

Text Quality
(see Settings)

Main screen

Application icons

Menu

Menu itemsScroll bar
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Edit field

Dialog box
A dialog box appears when you need to enter information
or give commands  to C-Pen. A dialog box contains one
or more objects such as edit fields or dialog buttons.

Edit field
It is possible to enter and edit text in an edit field. An edit
field is recognized by its dotted line.

Dialog button
Dialog buttons are used in dialog boxes to give simple
instructions to C-Pen.

Common dialog buttons

Edit field Dialog buttons A dialog box

Checked box

Unchecked box
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GETTING STARTED
Installing the batteries
1. Remove the battery cover from the rear panel of

C-Pen.

2. Insert two alkaline AAA batteries (1.5 V type LR03)
as shown below.

It is imperative to observe the polarity of the batteries.
The orientation of the plus and minus ends are shown
inside the battery compartment.

3. Replace the battery cover. You should hear a “click”
when it locks.

Do not dispose of batteries in a fire – there is a danger of
explosion. Please, recycle batteries!

!

Lift the cover here to open

!
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Turning C-Pen On and Off
To turn C-Pen on and off, press the On/Off  button until
the display is activated/deactivated.

C-Pen turns off automatically after 4 minutes of non-use.
To change the automatic power-off time, see System
Settings, p. 45.

Navigating and selecting
Nav (the navigation control) is used for navigation and to
select an object.

Turn Nav left or right to navigate between

• menu items

• dialog buttons

• edit fields

• check boxes

• lines or characters in text

As you move between objects,
they become highlighted
(inverted) one by one.

Pressing Nav briefly when an object is highlighted is
referred to as selecting that object.

Press to turn C-Pen on and off

Press to select
an object

Turn to navigate
between objects



16

The result when selecting an object is explained for each
situation later in this manual. Below are some general
remarks about selecting objects.

Menus
Selecting a menu item marked with a  will display
further alternatives in a new menu.

Menu item with alternatives

Selecting CANCEL  will close the menu. Instead of
selecting CANCEL , you can press ESC.

Dialog buttons
In a dialog box you instruct C-Pen how to continue by
selecting a dialog button:

OK You accept a suggestion in a dialog box.

YES Your answer is “Yes” to a question in a dialog
box.

NO Your answer is “No” to a question in a dialog
box.

CANCEL The dialog box closes and you return to your
earlier position. Instead of selecting CANCEL ,
you can press ESC.
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Edit fields

To be able to edit text in an edit field you have to select it.
A cursor will appear in the edit field and the status field
shows the edit mode symbol. See Editing text, p. 21.

Check boxes
To mark an alternative in a list of check boxes, navigate
to the alternative of your choice:

Execute the change by selecting the alternative. The
checkbox becomes checked:

Cursor

Edit mode symbol

Edit field



18

READING AND SAVING TEXT
Please follow the instructions in this chapter in order to
get the best results from your C-Pen. Take a few minutes
to learn how to use C-Pen correctly. (See also Optimum
reading conditions, p. 6)

Reading text
To read a line, follow the steps below.

1. Turn C-Pen on. Make sure that the text settings are set
to the appropriate values. The text settings are TEXT
QUALITY , TEXT  LANGUAGE  and READ MODE . There is
also a possibility to calibrate C-Pen for best perfor-
mance. Refer to Settings, p. 42, to read about the
different settings and how to modify them.

2. Place C-Pen over the
first character you want
to read. Hold C-Pen with
the pen tip flat against the
surface. Aim at the center
of the line. C-Pen reads one
line at a time.

3. Press and hold Trigg .

NOTE:   If Trigg is
pressed and held for
more than two seconds
and C-Pen is not moved,
C-Pen will enter calibration
mode, see p. 43.

!
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4. Move C-Pen over the
line of text. Keep Trigg
pressed as you move
C-Pen over the text.

5. Release Trigg  at the
end of the line.

The Text screen will appear.

The read text is placed in a new text file in Notes; see
p. 33. You can also create a new, empty text file by
selecting NEW... and then FILE  in Notes, before you start
reading.

NOTE:  You can move C-Pen either left-to-right or right-
to-left over the text.
You can read up to 15 cm/second.!

15 cm/s

Text screen
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Reading another line
Read the second line the same way you read the first. A
space or a line break is inserted between the lines (see
Read Mode, p. 43). You can also insert a line break by
clicking Trigg  once.

The last line is highlighted (inverted), i.e. white text on a
black background. To cancel the last line, press ESC briefly.

Deleting a line
To delete any of the read lines, do in the following way:

1. Place the cursor (the flashing triangle) in front of the
line and press Nav. The Text menu opens (see p. 35).

2. Scroll through the menu items until you find SELECT
and press Nav. The line becomes highlighted.

3. Press ESC briefly. The line disappears.

4. Press Nav to open the Edit menu (see p. 21) and
select QUIT  EDITING . You are ready to read a line again.

Saving text
Press Nav to open the Text menu (see Notes, p. 33) and
choose EXIT . The SAVE AS dialog box appears. Choose
YES  if you want to save the text, NO if you want to
discard the text or CANCEL  if you want to return to the
text. The dialog box also contains an edit field with a
suggested file name. You can change the file name before
you save the file; see Editing text on the following pages.
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EDITING TEXT
To be able to edit text in a text file or in an edit field you
have to enter edit mode.

Entering edit mode
You enter edit mode in different ways depending on your
starting-point. You can enter edit mode in the Text screen
or in edit field.

Entering edit mode in the Text screen
Press Nav in the Text screen to open the Text menu.
Select EDIT  to enter edit mode. You can now edit text
either by using the Edit menu (see below) or by using
C Write (see p. 25).

Entering edit mode in an edit field
Press Nav when the edit field is highlighted to enter edit
mode. You can now edit text either by using the Edit
menu (see below) or by using C Write (see p. 25).

Edit menu
When you are in edit mode a cursor appears and the edit
mode symbol is shown in the status field.

Edit mode symbol
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In edit mode you move the cursor one character at a time
by turning Nav. Move the cursor to a position where you
want to edit the text. Press Nav to open the Edit menu.

               

The items in the Edit menu are:

QUIT  EDITING Leaves the edit mode in the Text screen.

DONE Leaves the edit mode in an edit field.

CHANGE Changes the character to the right of the
cursor.

INSERT Inserts new characters at the cursor’s
position.

CUT Cuts a selection (available only if
characters have been selected)

COPY Copies a selection (available only if
characters have been selected).

PASTE Pastes a cut or copied selection (available
only if a selection has been cut or
copied).

DELETE Deletes a character or  a selection.

SELECT Highlights characters or a whole text.

SETTINGS Sets the text settings of the text you are
reading.

CANCEL Closes the edit menu.
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Some of the menu items are explained more in detail
below:

Change
Place the cursor to the left of the character you want to
change and select CHANGE from the menu.

Turn Nav to select the new character from the character
set and then press Nav.

Insert
Move the cursor to the place where you want the inser-
tion and select INSERT from the menu. You can choose
between inserting a space, a line break, a character or
multiple characters.

Select CHARACTER  in the insert menu to insert one
character. Then turn Nav to select a character from the
character set and press Nav. The character set closes
automatically after the insertion.

To insert more than one character, select MULTIPLE
CHARACTERS . Turn Nav to select a character from the
character frame and press Nav. The character set remains
on the display and you can continue inserting characters.
When you are finished, press ESC to return to the text
you are editing.

The character set
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Select
Use the SELECT command to edit more than one charac-
ter at a time. Then select CHARACTERS  and turn Nav to
mark multiple characters. Press Nav and choose CUT,
COPY or DELETE  from the menu.

If you select ALL , the whole text will be selected.

Delete
Place the cursor to the left of the character you want to
delete and select DELETE  from the menu.

If you have selected text, the whole selection will be
deleted, see Select above.

Settings
You can change text settings here. More detailed explana-
tions of the settings can be found in Settings, p. 42. The
text settings are

• TEXT  LANGUAGE : Select the language of the text you
are reading.

• C WRITE  FEEDBACK : Mark the checkbox if you want
the C Write  visual feedback to be on. See p. 25.

• READ MODE: Select Continuous or Separate lines.

• TEXT  QUALITY : Select Normal or Inverted.

• CALIBRATION : Select DEFAULT  SETTING if your
C-Pen is calibrated and you want to revert to the
factory setting.

Quit Editing
Quit edit mode by selecting QUIT  EDITING .
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C Write
C Write  is a feature that allows you to draw characters
by using C-Pen as an ordinary pen. C-Pen can track its
own movement over a surface and recognize the move-
ment as a letter, digit or a symbol. Using C Write  is an
alternative to using the character frame when inserting
characters in a text.

To be able to use C Write , the surface you “write” on must
have a distinct pattern. A printed text is the best choice.

Use C Write  in the following way:

1. Enter edit mode

2. Position the cursor

3. Place C-Pen against a text surface

4. Press and hold Trigg
5. Form a letter (see C Write  Prototypes, p. 28)

6. Release Trigg
When you release Trigg  an image will briefly turn up,
showing the letter shape as perceived by your C-Pen. You
do not have to wait for this image to disappear to write
your next letter.

This visual feedback can be switched on/off in Settings.
Select C WRITE  FEEDBACK . A dialog box appears where
you can check or uncheck the feedback utility.

Visual feedback
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Basic rules when using C Write
• In order to obtain maximum accuracy when writing

with C-Pen, your characters should resemble the pro-
totypes on the following pages as much as possible.

• A character must be drawn in one single stroke.

• The dot indicates the starting point of the stroke.

• The height of the character should be 1 - 4 cm.

• Trigg  must be pressed before you start writing.

• It is important that the pen tip is in contact with the
surface while you are writing.

• The writing surface must have a distinct pattern, such
as a printed text. Solid colors or simple repetitive
patterns (lines, squares, grids) should be avoided.

Capital letters
When you enter edit mode the status field will look like
this:

The edit mode symbol indicates that C Write  will
generate lowercase letters.

In order to write a capital letter, you have to write the shift
sign first (see C Write Prototypes). Only the first letter
will be a capital. The status field will reflect this choice.

Start here

The edit mode symbol shows
the C Write Lowercase icon

C Write Capital letter icon
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If you write two shift signs, C Write  will enter Caps
Lock mode. All letters will be capitals until you write a
shift sign again.

Symbols
Press Trigg  briefly to enter symbol mode. The status field
displays the Symbol mode icon.

Write one of the symbols in the symbol table. You are
automatically brought back to normal mode. If you want
to quit symbol mode without writing a symbol, you have
to write a backspace sign.

C Write Caps Lock mode icon

C Write Symbol mode icon
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C Write Prototypes
Letters, digits and shift

Shift Space Backspace New line

Aa Bb Cc Dd Ee

Ff Gg Hh Ii Jj

Kk Ll Mm Nn Oo
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Pp Qq Rr Ss Tt

Uu Vv XxWw Yy

Zz

1 2 3 4 5

6 7 8 9 0
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Special characters

Accents and umlauts

Write the letter first and then the accent or umlaut.
Example: ä = a + 

Symbols

Enter symbol mode by pressing Trigg briefly.

Çç Ææ Øø

¨ º ^ ´ ` ~

. , : ; / \
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( ) [ ] { }

- + * $ @ “

# _ < > ? ¿

! ¡ £ § ß %
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APPLICATIONS
C-Pen’s application icons are shown in the Main screen.
You can move between the icons by using Nav. Press
Nav to start an application.

Notes contains text files. See p. 33.

C Address is an address book, where you
can store business cards and search for
contact information. It can be synchronized
with Microsoft Outlook. See p. 36 and 52.

Settings contains parameters you can
change such as power-off time and reading
options. See p. 42.

Info contains information about your
C-Pen’s serial number, OS version number,
free memory space, etc. See p. 47.

C Direct contains information on how to
transfer text from C-Pen directly into a
Windows program by means of infrared
communication. See p. 53.

Move between the
icons with Nav

Main screen
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Notes
Notes contains the text files you have read and saved. Enter
Notes by selecting the Notes icon in the Main screen.

Inside Notes, move between items using Nav.

Creating a new file or folder
Selecting NEW... will open a dialog box:

Select FILE  to create a new file.

You do not have to do this command to create a file. A
new file will automatically be created whenever you
start to read with C-Pen (except when you already are in
the Text screen). New text files will be placed in Notes.

Select FOLDER  to create a new folder. A dialog box
appears.

Select the edit field to give the folder a name.

Your list of text
files starts here

!
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Use your C-Pen to read a name or press Nav to enter edit
mode. To save the folder, select OK . The folder is placed
in Notes.

If you want to save a file within a specific folder, you
must create the file by opening the folder, selecting
NEW... and then selecting FILE  in the dialog box.

The Command menu
The Command menu contains commands for handling
texts. Open the menu by selecting a text file.
The options in the Command menu are:

OPEN Opens the selected file.

RENAME Renames the selected file. A dialog box
with an edit field appears.

DELETE Removes the selected file.

PROPERTIES Displays the file size of the selected file. If
the file is created on a PC and transferred
to C-Pen, the creation date will be shown
as well.

CANCEL Closes the Command menu.

Press Nav to open the Command menu
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The Text menu
In the Text screen you move the cursor line by line with
Nav. You can insert a new line at the cursor position (the
flashing triangle) by reading a new line with C-Pen.

Press Nav if you want to edit the text, change text settings
or stop working with the text. Pressing Nav opens the
Text menu.

The items in the Text menu are:

EXIT Closes the text. If the text has been changed
you are prompted to save it before it is
closed. Select SAVE AS... if you want to save
the changed file with a new name.

EDIT Enters edit mode. See p. 21.

SETTINGS Opens the text settings of the text you are
reading. See Settings, p. 42.

SELECT Highlights a read line/word. When using this
command, you automatically enter edit
mode.

CANCEL Closes the Text menu.

Press Nav to open the Text menu
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C Address
C Address is an application in C-Pen for storing and
looking up contact information such as addresses, phone
numbers and e-mail addresses to people and organiza-
tions you communicate with.

Start C Address by selecting the C Address icon in the
Main Screen.

C Address
main screen

The C Address main screen will open:

Below the menu items EXIT , NEW... and FIND  you will
find your contacts in a list.

Contact list

Enter a new contact
To enter a new contact, select NEW... in C Address main
screen. The Contact edit screen will open:

Contact edit
screen

Main screen
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In the Contact edit screen, turn Nav to go to the first
field, called First name. Read the first name of your
contact with your C-Pen, for instance from a business
card or a telephone list. Redo the reading if you are not
satisfied or turn Nav to move to the next field, Last
Name. Read the last name to this field, and then move to
the next field called Full name. The name in this field
will later be suggested as your contact file name. Con-
tinue reading text into the following fields in the same
way.

You can always move to any field you want by turning
Nav. If you want to redo a reading with C-Pen, just go to
the field that you want to change and read again. Enter
edit mode if you want to edit the content of the field (see
p. 21).

You can change the choice of contact details (addresses,
phone numbers, e-mail addresses etc.) in OPTIONS. Select
OPTIONS and scroll through the options. Check or uncheck
the boxes according to your personal preferences. When
you are finished, select OK or just press ESC.

You can discard the information you have entered in a
contact file by selecting CANCEL . Select YES, when a
dialog box appears, asking if you want to discard all
changes.

Check boxes
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Selecting TOP at the end of the field list brings you to
SAVE &  CLOSE.

Select SAVE &  CLOSE when you are finished . The Save
As dialog box appears. The suggested file name is the
name you entered in the Full name field. If this field is
empty or unchecked the suggested file name will be
“Last name, First Name”. You can edit the file name or
you can read a file name with your C-Pen.

A file name must not be longer than 64 characters.
Invalid characters like ‘\’ or ‘.’ will be replaced with a
blank space. If the file name already exists, a number
suffix will be added to the file name, for instance ‘John
Mill (1)’ if ‘John Mill’ already exists.

Select YES to save the contact file. A new contact is added
to your contact list.

The contact menu
The Contact menu contains options for working with
contact files. Open the menu by selecting a contact in the
contact list.

The options in the Contact menu are:

VIEW Lets you view the information you have
entered about a contact.

EDIT Lets you edit the information you have
entered about a contact.

Contact
menu
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DELETE Deletes the contact file.

TOP Brings you to the top of the C Address main
screen (EXIT ).

CANCEL Closes the Contact menu.

View a contact
Select VIEW  to view a contact. The contact information is
presented in the Contact view screen. At opening the
scroll bar rectangle is blinking, which indicates that the
scroll bar is active, and you are able to scroll through all
contact information.

To select OK  or EDIT , first press Nav to deactivate the
scroll bar – the rectangle stops blinking – then turn Nav
to go to the buttons.

Edit a contact
There are two ways to edit a contact:

1. Select a contact in the contact list. Then select EDIT  in
the Contact menu.

Blinking when activated

Contact view
screen
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2. Select EDIT  in the Contact view screen.

In both cases the Contact edit screen will open, display-
ing the stored information in the fields. You can move
between the fields by turning Nav. If you want to change
the content in a field, you can read a new field text with
C-Pen or edit the text in the usual way.

Find a contact
To find a contact, navigate to the C Address main screen
and select FIND . The Find contact screen will open.
Enter the search text either by using C Write  or inserting
characters from the character set.

If the Search all fields check box is checked, all informa-
tion stored in C Address will be searched in order to find
matching text.

If the check box is not checked only names will be
searched, (First name, Last name and Full name).

Select FIND  to start the search. The Find contact screen
closes and a contact list containing only the contacts with
matching information will be displayed. You can select
these files, just as you do in the contact list.

Find contact
screen



41

Select DONE to close the screen and return to the
C Address main screen.

If no matching text is found, a dialog box appears telling
you “Nothing found”. Select OK  to go back to the Find
Contact screen.

Delete a contact
Select a contact in the contact list and select DELETE . A
dialog box asks you to confirm that you are sure. Select
YES. The contact is now deleted.

Exit C Address
You can exit C Address from the C Address main
screen by selecting EXIT  or by pressing ESC.

Search result
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Settings 
Settings contains the parameters controlling C-Pen. Enter
Settings from the Main screen by selecting the Settings
icon. You can also enter text settings from the Text menu
(p. 35) and the Edit menu (p. 21). A list of the available
settings appears.

To modify a setting:

1. Select the setting from the settings list. A dialog box
appears.

2. Turn Nav to highlight the setting value. Press Nav to
modify.

3. Turn Nav to change the value and press Nav to
confirm.

4. Select the OK button to close the dialog and save the
changed setting.

5. Exit Settings by selecting Exit at the top of the
Settings list.

The following settings are available:

• Text Language

• Read Mode

• Text Quality

• Calibration (available from the Text menu and Edit menu)

• C Write Feedback

• System Settings

Text Quality, Text Language and Read Mode are
referred to as text settings. You must use these text
settings in order to achieve the optimal OCR.
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Text Language
Select the language of the text you want to read from the
list of check boxes. If you read text containing numbers
only, select Numbers Only as language.

Read Mode
This setting indicates how C-Pen should format the
readings. The read modes are:

CONTINUOUS TEXT : A space is inserted between two
separate readings with C-Pen.
Suitable when you read a complete
paragraph which will be used in a
document on your PC.

SEPARATE LINES: Each reading starts on a new line.

Text Quality
Use this setting to indicate if the printed text is normal or
inverted

NORMAL : Black text on white background.

INVERTED : White text on black background.

Calibration
C-Pen’s reading ability can be adjusted to the contrast
between the text and its background in the following
way:

1. Hold C-Pen with the pen tip flat against the surface.

2. Press Trigg for two seconds without moving C Pen.

3. A progress indicator appears on C-Pen’s screen.
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4. Move C-Pen over the text, in circles or back and forth.
Continue to move C-Pen until the progress bar has
reached the end.

5. A message shows up to indicate that the calibration is
ready:

During the calibration process, C-Pen will find the
appropriate balance of black and white for the particular
surface.

When your C-Pen is calibrated the Text Quality icon in
the status field changes appearance:

The calibration overrides the factory setting. The calibra-
tion is not saved when C-Pen is turned off. If you want to
revert to the factory setting without turning C-Pen off,
choose CALIBRATION  under Text menu/SETTINGS or
Edit menu/SETTINGS:

Select CALIBRATION  and a dialog box appears:
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In the calibration dialog box, select DONE to go back or
DEFAULT  SETTING  to revert to the factory setting. If you
press the scan button (Trigg ), a calibration will start.

You can do a calibration whenever you use C-Pen. This
method increases C-Pen’s reading ability if the text is not
black and/or the background is not white. Inverted text
must still be set in Text Quality . Remember that red text
is not possible to read. If the calibration does not improve
the reading accuracy, return to the default setting.

C Write Feedback
Check the box if you want to enable the visual feedback
facility in C Write .

System Settings
PIN CODE You can control the access of your

C-Pen by a four-digit PIN code. Enter
the PIN code setting to enable or disable
your PIN (Personal Identification
Number).

When the dialog box opens, the zero in
the first position is blinking. Turn Nav to
select the first digit in your PIN. Then
press Nav to go the next position.
Continue in the same way. When you
have reached OK ,  press Nav and
confirm the PIN in a new dialog box.
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If PIN-code is enabled, you must enter
the PIN each time C-Pen is turned on.
After three unsuccessful attempts, C-Pen
will turn off. You get three attempts each
time you start C-Pen.

Warning!  If you start C-Pen by select-
ing DISABLE  PIN CODE in the start up
dialog box, all data in C Pen will be lost!

You can change or disable your PIN
code by selecting PIN CODE in System
Settings.

CONTRAST Display contrast. Select the bar and turn
Nav to change display contrast.

MENU The language that C-Pen uses in its
LANGUAGE menus and dialog boxes. Select the

desired menu language in the list of
check boxes.

POWER OFF The time of inactivity in minutes before
TIME C-Pen turns off automatically.

RIGHT /LEFT - A right/left-handed option. Check
HANDED RIGHT  or LEFT  to orientate the text on

the display for right- or left-handed use.
Select OK  and press Nav.

EXCHANGE An option to exchange the functions of
TRIGG /ESC Trigg and ESC. Unchecked box means

normal use, see figure p. 10.
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Info
Info  contains a list of help and information topics.

EXIT Exits Info .

GETTING  STARTED Gives instructions on performing a
successful reading. Press Nav or
ESC to close the topic.

TROUBLESHOOTING Gives solutions to common
problems. Press Nav or ESC to
close the topic.

SUPPORT Contains support addresses to
C Technologies.  Press Nav or ESC
to close the topic.

ABOUT C PEN Contains OS version number, HDB
version number and serial number.
You should know these numbers if
you contact C Technologies for
support. You can also see the
amount of free memory space.
Select the scroll bar and turn Nav
to scroll through the information.
To close the topic, deactivate the
scroll bar by pressing Nav or ESC,
then select OK  or press ESC.
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CONNECTING TO A PC
C-Pen can be connected to a PC by Infrared (IR) commu-
nication. A working IR connection with a PC is required
to install and remove applications in C-Pen. To enable
this communication certain hardware and software must
be installed and configured properly on your PC. The
following is required:

1. IR port. Laptop computers often have a built-in IR
port. Refer to your computer’s manual to find out
whether your computer is equipped with an IR port
and if so, where it is located. Most desktop computers
do not have a built-in IR port. In this case you must
use an external IR adapter. Refer to your retailer if you
don’t have an IR adapter.

2. Infrared drivers for Windows 95 (included on the C-Pen
Windows Software CD). If you use Windows 98 or
Windows NT, please read the ReadMe file on the C-Pen
Windows Software CD.

3. C-Pen Windows Software. This software is installed
using the C-Pen Windows Software CD.

Installing software
The Infrared drivers and the C-Pen Windows Software
are installed when you run the installation programs on
the CD. Infrared drivers are possibly already installed on
your computer.

Infrared hardware on laptops can be configured in many
different ways. Please refer to the ReadMe file on the
C-Pen Windows Software CD before installing infrared
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software on a laptop. If you have questions and the ReadMe
file does not help, please refer to C-Pen Windows
Software Help or your laptop retailer or manufacturer.

To install C-Pen Windows Software:

1. Put the C-Pen Windows Software CD into your
computer’s CD-ROM drive and the installation
program will start automatically.

2. If the installation does not start, open the Start menu in
the Windows taskbar, select Run and type d:\setup.exe,
where d: is the drive letter for your CD-ROM drive.

3. To install C-Pen Windows Software, click on Install C-Pen.

If no Infrared drivers are installed on your computer,
click on Install Infrared to install these (Windows 95 and
98 only).

The installation program also enables you to view the
C Pen Demo, which demonstrates how you should use
C Pen for best results. To play the demo, click on Demo.

To open the ReadMe file, click on ReadMe.

Connecting C-Pen to a PC
To connect C-Pen to your PC, position C-Pen so that it is
aligned with the PC’s IR port as shown in the figure.
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When C-Pen is within range of the computer’s IR
port, an IR icon will appear in the status field on
C-Pen’s display. On most laptops the built-in IR port
- a red or black glossy square - is found on the back or
side of the computer.

The installation program has placed the C-Pen icon (My
C-Pen) on your computer’s desktop. Double-click on the
icon to connect to C-Pen.

Getting help
To get more detailed help using C-Pen Windows Soft-
ware, first open C-Pen Viewer (by double-clicking on My
C-Pen) and from the Help menu select C-Pen Help
Topics. You can also press F1 on your keyboard to enter
C-Pen Windows Software Help.

C-Pen Viewer
Open C-Pen Viewer by double-clicking on My C-Pen.
C-Pen Viewer enables you to browse the contents of your

C-Pen Viewer
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C-Pen. The user interface looks like Windows Explorer
and you will recognize the applications from the Main
screen in C-Pen. Use C-Pen Viewer to open and browse
files in your C-Pen , to create new folders and to remove
applications from your C-Pen.

Installing and removing applications
The applications in your C-Pen can be removed and new
ones installed. To install a new application in C-Pen
simply double-click on the “.car” file (C-Pen Archive)
from anywhere on your computer and the installation will
begin. You need to turn C-Pen off and on again to complete
the process.

To remove an application from C-Pen select the applica-
tion in C-Pen Viewer and choose Uninstall C Pen
Application  from the File menu and follow the instruc-
tions on the screen. You need to turn C-Pen off and on
again to complete the process.

Transferring files
Transfer files between C-Pen and the PC the same way as
when working with a floppy disk or a hard drive. In C-Pen
Viewer, find the file you want to transfer (e.g. a text file
in Notes) and drag the file to a folder on your PC.

When transferring files from the PC to C-Pen, remember
that each application accepts only its own kind of files.
Notes, for example, may only contain text files.
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C Address
C Address, the C-Pen address book, is available in C-Pen
Viewer on your PC. Double-clicking on C Address in
C-Pen Viewer presents the address files stored in C-Pen,
listed by their contact name.

The address files are stored as vCard files (filename.vcf)
and can be opened by a vCard viewer such as Netscape
Communicator or Microsoft Outlook/Microsoft Outlook
Express on your PC by double-clicking on it and then
clicking Yes in the dialog. Please note that this will open
a copy of the file and that your changes will be saved on
your hard drive, not in C-Pen.

To put an edited address file back into C-Pen, simply
drag it from a folder on your PC and drop it into the C
Address application in C-Pen Viewer. Note that the
dropped file cannot have the same name as an existing
file in C Address. If it does, you are prompted to change
its name or replace the existing file in C-Pen.

It is possible to synchronize your address files in
C Address with those in Microsoft Outlook (but not
Microsoft  Outlook Express). Simply click your right
mouse button on the My C-Pen icon on the PC desktop
and the option C Address  Sync will appear. Selecting it
will start an easy-to-use application allowing you to
specify the extent of synchronization. Please note that
this application only works if you have Microsoft
Outlook installed on your computer.
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C Direct
C Direct gives you the opportunity to enter text from
your C-Pen at the cursor position in Windows programs.

To activate C Direct place C-Pen in front of the IR port
on your PC, click the right mouse button on the C-Pen
icon (My C-Pen) and select C Direct from the context
menu. The C Direct icon will appear in the system tray in
the lower right corner of your screen. The
system tray holds icons of frequently used
functions in Windows e.g. volume control
and time.

The display on your C-Pen will show “C Direct”.

When you read text now with C-Pen, it will appear as
usual on the display. To transfer the text to the active
application in Windows, direct C-Pen’s IR-eye towards
the IR port of the PC. The text will disappear from
C-Pen’s display and be transferred to the cursor position
in the active Windows application.

The easiest way to control C Direct is from the C Direct
icon in the system tray in Windows. By clicking the icon,
you can choose Connect, Disconnect or Exit C Direct .
To activate C Direct you can simply double-click the
icon. For more information on how to use C Direct,
please refer to the C-Pen Windows Software Help.

System tray
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C-Pen Edit
C-Pen Edit is a simple text editor that lets you edit files
stored in C-Pen directly, without having to first move
them to your PC.

C-Pen Edit can communicate directly with your C-Pen to
open and save files. If you are using C-Pen Edit and
open a file from C-Pen, it can be saved either to your
hard drive or directly back into C-Pen. The same applies
when you open a file from your hard drive.

C-Pen Edit provides basic text editing, such as cut, copy,
paste, find and replace. If you double-click on a text file
in Notes in C-Pen Viewer, it is automatically opened in
C-Pen Edit.

Closing the connection
Close the connection between your C-Pen and your PC
by selecting Disconnect C-Pen from the File menu in
C-Pen Viewer or simply by closing the C-Pen Viewer
window.
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TROUBLESHOOTING
Problem: C-Pen will not turn on.

Solution: The batteries might be depleted. Replace the
batteries.

You must press the On/Off button for one
second.

 Problem: The text on the display does not match the
text you are reading.

Solutions: Make sure you have chosen the correct Text
Language in Settings. See p. 43.

Make sure that you have chosen inverted text
if the text is white on black background, or
normal text if you have black text on white
background. See Read mode in Settings,
p. 43.

Make sure that you hold C-Pen so that the
pen tip is flat against the surface of the text
you are reading. If you have an angle
between the nose and the surface, C-Pen will
take incorrect pictures of the text.

Calibrate your C-pen to the present contrast
between the printed text and its background.
See Calibration , p. 43.

Reset the calibration to the factory setting.
See Calibration , p. 44.
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Problem: A dialog box with the message “Nothing
read” appears.

Solution: You must keep Trigg pressed as you move
C-Pen over the text.

You must hold the pen tip flat against the
surface before you press Trigg .

Problem: The infrared communication to the PC does
not work.

Solutions: Make sure that you have an external IR
receiver installed on your stationary PC. If
you have a portable PC, it is normally
equipped with a built-in IR receiver.

Check Infrared under the Control panel in
Windows 95/98.

Problem: C-Pen turns itself off too quickly.

Solution: Enter System Settings (p. 45) and increase
Power-off time.

Problem: I am left-handed and the text on the display
is upside-down.

Solution: See RIGHT /LEFT -HANDED in Settings, p. 45.

Please refer to the C-Pen Windows Software Help for a
more extensive troubleshooting section.
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TECHNICAL SPECIFICATIONS
Size: 140x35x24 mm

Weight: 80 g (including batteries)

Display: 2 rows

Processor: Intel© StrongARM™ 100 MHz

Memory: 512 kB RAM
2 MB flash memory,

Battery lifetime: 3–4 weeks normal use

Reading speed:15 cm/s

Character sizes:7–20 points
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Editing text  21
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WARRANTY
C Technologies AB warrants that this product is free from defects in materials and function at the time of
original purchase and for a period of one year from that date. When the name C Technologies is mentioned
in the following text, it means, unless otherwise stated, C Technologies AB (reg. number 556532-3929), its
subsidiaries and retailers.

If, during the warranty period, any defect in the product arises due to a deficiency in materials or function,
C Technologies pledges to, at C Technologies' option, either repair or replace the defective product with the
same or an equivalent model.

C Technologies, however, takes no responsibility for:

1. Damage caused during shipping, by accidents, malicious damage, modification, incorrect usage, force
majeure or any cause beyond the control of C Technologies, including but not limited to lightning,
water, fire, public disturbances, riots, strike, war or other similar conflicts.

2. C Technologies is not responsible for damage (including but not limited to direct or indirect personal
injury, lost profits, fall in production, losses of or alterations to processed information or any other
incidental or consequential damages) caused by the product or the usage of the product or because the
product cannot be used.

3. Deficient maintenance or a repair performed by unauthorized persons.

4. Incompatibility due to technological developments.

5. Defects caused by external equipment or abnormal wear.

6. Defects caused by normal wear and tear.

7. Damage caused by the usage of inappropriate battery.

8. Damage arising in connection with or as a consequence of upgrading with additions to or alterations of
the product, using software or hardware not produced by or approved in writing by C Technologies.

If your C-Pen product requires warranty service you should return the product to the dealer/retailer from
whom it was purchased. The product must be packed in original packaging or with sufficient care so as to
avoid shipping damage. The original purchaser must be able to show proof and date of purchase with
receipt/invoice from point of purchase in order for this warranty to be valid.

Repair or exchange does not extend or renew the warranty period. Exchanged defective parts become the
property of C Technologies. When the warranty period has expired, the warranty of exchanged/replaced
parts also ceases.

This product is not to be regarded as having defects in materials or function if it must be rebuilt in order to
be modified in accordance with national or local technical safety regulations in a country other than one
that the product was meant to be used in.

C Technologies reserves all rights to the product, its hardware, software and trademark. Whoever buys or
uses the product has no right to alter, disassemble, reverse engineer or in any other way use any part of
the hardware or software in the product, except in the way and for the purposes permitted by law.

This warranty does not affect the purchaser's rights against the dealer arising from the sales/purchase
contract, nor the purchaser's legal rights according to existing, mandatory rules in applicable laws.

If there are no such applicable laws or mandatory rules, the purchaser's rights are limited to those which
are stated in this warranty. C Technologies shall not be liable for any incidental or consequential damages
for breach of any expressed or implied warranty of this product.
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Warranty Information

Serial number:

Customer:

Date:

Address:

Dealer:

Address:

CT number:


